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Getting Started

Installing The Athlete's Calculator in Your Palm

Whether you downloaded the software from our Web site or received it in the mail, you should have 
a file called AthCalc.prc on your desktop or laptop computer (on the hard disk or on a floppy 
diskette). If you have a file named AthCalc.ZIP, that is not the proper file; that's a compressed or 
"zipped" file that you must uncompress with standard "unzipping" software (which we do not 
provide). If you are running Windows XP, you MUST "extract" the files from the ZIP file before 



proceeding.

If you do not have the file AthCalc.prc , you cannot proceed. If you do have 
AthCalc.prc, here's how to install it on your handheld unit:

Windows:

Double-click on the file Install.exe, and the entire installation process will be self-explanatory.

If anything goes wrong with that approach, double-click on the file AthCalc.prc . A window 
labelled Install Tool should appear, with a UserName selection box with the name of one or more 
Palm handheld units. Select the one you wish to install the software in, and click on OK. A second 
Install Tool window will appear, showing AthCalc in a list of programs to be installed. Click on 
Done, and another window will appear informing you that AthCalc will be installed in your Palm 
the next time you do a HotSync. Perform a HotSync and the software will be installed.

Macintosh:

Select Install Handheld Files from the HotSync menu. Make sure the User is set to the 
handheld unit in which you want to install the software, and drag the AthCalc.prc file into the large 
box in the window (or use the Add To List button to select the file). Close the window, perform a 
HotSync, and the software will be installed.

Starting the Application

From the Applications window on your Palm, look for the icon labelled AthleteCalc which 
looks like this:

Entering Your Serial Number/Unlocking the Application

After clicking on the icon, the application will start and you'll see this screen:

The second time you use the program the Calculate button will read Enter S/N, and the 
calculation functions will be disabled until you enter the seven-digit serial number that you were 
provided when you purchased the software. Enter the serial number by tapping on the numbers in the 
lower-left of the screen, and then tap on Enter S/N. If you enter the number correctly, the button 



will change to Calculate and you can proceed.

If you run into a problem, this probably means that when you provided your Palm name to Stevens 
Creek Software, you did so incorrectly. In order to provide you with a serial number for your 
software, we need the *User Name* of your PalmPilot. To get the User Name, tap on the 
Applications button, then tap on the HotSync application. If you have a PalmPilot (Personal or 
Professional), the top line of the screen will read, "Welcome, XXX." "XXX" is your user name; 
that's what we need. If you have a Palm III or IBM WorkPad, the name appears in the extreme upper 
right of the same HotSync screen. Please be sure you supply it to us EXACTLY as it appears, 
including upper or lower case letters, punctuation, and spaces as appropriate. Just email it to Stevens 
Creek Software technical support and wait for a new serial number to be provided to you.

Getting Help

We recommend of course continuing to read this manual to learn about all the features of The 
Athlete's Calculator. Once you are running the software, there may be a few things you can't 
remember. If you select any of the "Help" options from the Help menu, you'll find help on the 
relevant subject:

Basic Data Entry

The Active Field

Along the top left, note the three buttons: Time, Distance, and Pace. The "active" field is always 
highlighted, and a round-cornered rectangle also helps to show you which information you are 
entering. The active field is the field into which you are currently entering a number. To switch the 
active field, just tap on either Time, Distance, or Pace to make that field the active field.

Entering a Number into the Active Field

To enter a number into the active field, tap on the numbers in the lower -left corner of the screen. The 
button marked Del is used to delete (erase) the last character entered; you can erase the entire entry 



by pressing the Clear button.

To enter "simple" numbers, just press the numbers in sequence, e.g., "32" or "26.2". To enter 
numbers which are times, do exactly the same thing, ignorning the need to enter the "colon" character 
(:); the software will insert those for you automatically. For example, "4517" becomes "45:17" 
automatically. Note that "34" is 34 seconds. To enter 34 minutes, enter "3400".

In this example, you want to enter a time of 3 hours, 25 minutes, and 23 seconds, so you tap the 
"3","2","5","2", and "3" buttons sequentially:

Now watch what happens when you tap on the Distance button in order to enter the distance:

Notice that the colons have been inserted into the time, and now the Distance field is active, so that 
tapping "26.2" enters that number into the distance field.

Note that if the "Number Format" set by the Prefs application on your Palm calls for a comma to be 
used as a decimal point instead of a period, the key next to the "Del" key will be labelled ",", as 
appropriate.



Calculating Pace

Now to calculate pace, just tap on the Calculate button. As you see at the right, the pace is 
calculated and displayed in the Pace field.

Setting Feedback Preferences

When you tap the buttons on the screen, you will by default hear a standard very light sound which 
is used in all Palm applications to indicate that a button has been tapped. In many applications, if you 
"miss" a button nothing will happen, so it's not that important to have aural feedback. In The 
Athlete's Calculator, however, if you miss a button you may get the wrong answer, so a special 
feature of the software lets you get a longer, louder feedback when you tap buttons.Tap the Menu  
button on your Palm, and select

Preferences from the Options menu. You'll see this screen:

If you check the button, you'll get a louder sound when you tap the buttons.

Using Graffiti for Data Entry

If you find it easier, you can use Graffiti (tm) as well as the on-screen buttons for data entry. The 
characters which are recognized are:

Data Entry
0-9 and . (period) - Add the character in the current field
Backspace - Erase the last character entered
c - Clear the current field
r - Reset (clear) all fields



Data Entry (for the Distance field only)
m - Switch to miles
k - Switch to kilometers
y - Switch to yards
f - Switch to feet

Navigation
Tab - Move from field to field (and calculate if appropriate)
t - Switch to time field
d - Switch to distance field
p - Switch to pace field

Actions
=, Return (new line) - Calculate
+, -, *, / - Perform indicated operation
s - Toggle button confirmation sound on and off

Using the Clipboard

The Edit  Menu  gives you four choices:

Cut and Copy will cut and copy the contents of the currently active field. Paste pastes the contents 
of the clipboard into the currently active field, but it can do much more, because all of the Graffiti 
commands listed in the previous section are active. Thus if you have (we'll use T for Tab and R for 
Return): "4523T10kTR" on the clipboard and go to The Athlete's Calculator and do a Paste, 
"4523" will be pasted into the Time field, then a Tab will skip to the Distance field (and convert the 
"4523" to "45:23" in the Time field, then "10" will be pasted into the Distance field and the units will 
be set to kilometers, then Tab moves to the Pace field and R (Return) calculates the Pace.

Copy All to Memo copies the contents of all three fields, plus the date and some other 
information, to the clipboard, and transfers you to the MemoPad application where you can paste the 
information into a memo. See Transferring Information using the Clipboard for more about this 
feature.

More Calculations

Calculating Time or Distance

The basic rule of The Athlete's Calculator is that it will always calculate an empty field if the 
remaining two fields are filled. So if your workout covers a known (or roughly known) distance at a 
known (or roughly known) pace, fill in Distance and Pace, press Calculate, and the Time will 
be calculated. You might do this, for example, to estimate your finishing time in a marathon - enter 
the distance and your estimated (or hoped-for) pace, press Calculate, and you'll see the expected 
finishing time (see example below). If you run an unknown route, you can estimate the distance by 
entering Time and Pace and pressing Calculate.



Enter distance and pace Press Calculate to calculate time

Repeating a Calculation

After a field has been entered and used in a calculation (by pressing the Calculate button), you can 
enter a new value in that field simply by entering a number; there's no need to press the Clear 
button. For example, let's say you are estimating your finish time in a marathon and you entered 
distance and pace, pressed Calculate, and saw the predicted finish time (as shown above). Now if 
you want to see the finishing time for a different pace, simply enter a new number and press 
Calculate (assuming Pace was already the active field; if it wasn't, tap on Pace first).

Enter a new pace Press Calculate again to calculate 
new time

Performing a New Calculation

To perform a completely new calculation, you can clear all three fields by tapping the Clear All 
button.

Units of Measurement

Selecting and Converting Units

Units for the distance and pace can be changed using the pop-up menus at the right of the screen:

Distance Units Pace Units

To enter a distance or pace in appropriate units, select the units before entering the number, unless 
you want to convert them. For example, if the distance units are in miles, and you enter "10" because 



you ran a 10K, now if you switch the distance units to kilometers (km), the number will 
automatically change to "16.09", because the program has converted 10 miles into 16.09 kilometers:

Enter distance in miles Change units

Of course you can use this feature intentionally. If you swim a pace of 1:20 per hundred meters, you 
can set the pace units to /100m, tap on Pace to make pace the active field, enter "120", and then 
change the pace units to mph or /mile to see what your pace is in miles per hour or minutes per 
mile, for example.

The last units you use are always saved, so that each time you start the application, it will return to 
your "default" units.

Using the Mini-Calculator
In the lower right corner of the screen you see four standard calculator buttons: + , - , * , and /, which 
allow you to perform addition, subtration, multiplication, and division, respectively. What is unique 
to The Athlete's Calculator is that these operations work on times expressed as 
hours:minutes:seconds as well as they do on "regular" numbers, and furthermore, whenever they are 
used to modify a number, the other fields are modified appropriately.

 Let's take an example. Suppose you read in a book of training advice that you should "do your long 
runs at a pace 30% slower than your 10K race pace." Let's start by assuming you know your most 
recent 10K time, but not the pace. First calculate your pace as described above - enter the time and 
distance, and press Calculate. Your screen should look like this:



 Because you now want to modify the pace, tap on Pace to make it the active field. Next tap the *  
button, followed by 1.3 . What you'll see at this point is shown at the left. The pace field is active 
and is enclosed by the large round-cornered rectangle, which lets you know that it is the field that is 
about to be modified. At the same time, your mini-calculator number appears just below the 
Calculate button, enclosed by a smaller round-cornered rectangle of its own to show you that that is 
the number you're currently entering.

Now when you press Calculate, two calculations are actually performed. First, the pace is 
multiplied by 1.3, as you requested with your calculation. Then the software proceeds with a 
recalculation. Because it doesn't make sense to recalculate pace from the time and distance (that 
would negate the effect of the multiplication!), the program instead recalculates the time:

At this point you have learned that if your 10K time is 42:10, your long run pace (according to this 
advice) should be 8:49/mile. You also see how long it would take you to run a 10K at that pace, but 
that probably isn't of interest. What you really want to know is how long it's going to take you to 
run your 20-mile run at that pace. To find out, tap on Distance, enter 20 , then tap on Calculate, and 
here's what you'll see:



Your 20-miler should take you just under 3 hours at the recommended pace.

Adding Split Times with the Mini-Calculator

You can use the calculator function buttons repeatedly, just like a real calculator, without hitting the 
Calculate button. For example, suppose you have just run a series of 400-meter intervals on the 
track, in times of 72.6, 73.4, 75.2, 72.8, 73.1, and 71.6 seconds. What was your total time spent 
running?

Press Clear All if you need to reset the calculator; that will also make Time the active field. Now 
enter 72.6 , tap + . You should see this:

Note that as the time was entered, it was automatically converted from 72.6 seconds to one minute, 
12.6 seconds. Now enter 73.4  and tap +  again. The program will add your two times, and, since 
the last key you pushed was +  and not Calculate, the mini-calculator is still active and ready for 
you to enter the next number:



Continue by entering: 75.2+72.8+73.1+71.6 . At the end, since you're done, tap the Calculate 
button to show the final total and de-activate the mini-calculator. If you're a user of The Athlete's 
Diary for Palm, you might use this feature, then select Copy from the Edit  menu to copy the total 
time to be pasted into The Athlete's Diary.

Limitations

The Athlete's Calculator is designed to deal with time, distance, and pace - all by definition are 
positive numbers. If you use the subtract function of the Mini-calculator and the result would be 
negative, the result is set to zero instead.

If a calculation results in a number too large to be displayed in the available space (or if you try to 
enter too many digits into any field), the field is reset to zero.

Any attempt to add, subtract, multiply, or divide by zero is simply ignored.

Calculating Splits

Showing and Using Totals

There is one final option in the software, which is activated using the menus. Press the Menu  button 
on the Palm, and then select Show Totals from the Options menu to activate the mode in which 
all calculations which are performed are added together automatically. If you tap the Menu  button 
again, you'll see that the first menu item has now changed to Hide Totals; tap on this to de-activate 
the automatic totals feature. The Athlete's Calculator will always remember the last setting 
(Showing or Hiding Totals), and will return to that setting when you use the calculator the next time.

There are two typical cases in which you will be interested in totals - the case of even (equal-distance) 
splits, and the case of uneven (unequal distance) splits. Both are similar, although in the first case 
you have fewer numbers to enter.

Let's take the previous example - the case of running a series of 400-meter intervals on the track. 
Here's the sequence of operations:



1. Tap on Clear All if necessary
2. Tap on the Palm's Menu  button. If the first item in the Options menu reads Hide 

Totals, cancel the menu (tap elsewhere on the screen); if the first item reads Show 
Totals, tap on it to activate the Totals mode.

3. Enter the first time: 72.6 .
4. Tap on Distance.
5. Tap on the units pop-up menu at the right, and select meters.
6. Enter 400 .
7. Tap on Calculate to calculate the pace of the first split.
8. Tap on Time to make it the active field.
9. Enter the next time: 73.4 , and tap on Calculate again. The screen should now look like 

this: 10.

11. Note that the large numbers show the current split (last lap's time, distance, and pace), 
while the small numbers below them show the total time and distance, and the average pace, 
over all of the laps which have been entered thus far. To continue entering and adding the 
remaining laps, simply repeat step 9 as many times as necessary - enter the lap time, press 
Calculate, and so on.

12. At the end, you might want to convert the distance units to some other units, like miles, so 
that you can see the total distance run in units more appropriate to longer distances. To do 
so simply select the distance units pop-up and choose the desired units. Both the latest 
distance as well as the total distance will be automatically converted.

What if the distances are unequal? Perhaps you do a bike ride where you ride to a mountain, ride up 
the mountain, ride down the mountain, and then ride home, and you want to know your average 
speed for the different legs of the ride. Your bike computer, of course, only shows your average 
speed for the entire ride, but if you measured the time and distance for each leg, The Athlete's 
Calculator can do the calculations for you. Or, perhaps you ran a 50K race in which you took your 
splits at each of the unevenly spaced aid stations. Again, The Athlete's Calculator can calculate 
your splits for each leg, as well as for the total race, all at the same time. You simply need to enter 
both time and distance for each leg of the workout or race; otherwise things are as above.

Predicting Finish Times

Another application - predict your finishing time in a marathon, assuming unequal paces during the 
race. Most marathoners figure the first 20 miles is one race; the last 6.2 another. Here's how you 
would calculate your estimated finishing time:

1. Tap on the Palm's Menu  button. If the first item in the Options menu reads Hide 
Totals, cancel the menu (tap elsewhere on the screen); if the first item reads Show 
Totals, tap on it to activate the Totals mode.



2. Tap Clear All to make sure all the fields and totals are zeroed.
3. If necessary, tap on the units pop-up menu and select the desired distance units - miles for 

distance and /mile for pace.
4. Tap on Distance and then enter 20 .
5. Tap on Pace. Let's say your estimated beginning pace is 7:45 minutes/mile, so enter 745 .
6. Tap on Calculate: 2:35:00 should appear in the time field, which is your time for the first 

20 miles..
7. Tap on Distance, then 6.2 .
8. Tap on Pace, then 815 , assuming you'll slow down 30 seconds/mile during the last 6.2 

miles.
9. Tap on Calculate and you should see the screen below, indicating that your total time will 

be 3:26:09, representing an average pace/mile of 7:52.1 over the full 26.2 miles:

Transferring Information Using the Clipboard
If you are looking for an athletic log program for your Palm, you should consider The Athlete's 
Diary for Palm. However, to a limited extent and with greater difficulty, The Athlete's 
Calculator for Palm can also be used to generate data which can be saved and merged into other 
applications, including the desktop version (Macintosh and Windows) of The Athlete's Diary.

Select Copy All to Memo from the Edit  menu. When you select this option (or its equivalent 
using Graffiti shortcuts), the distance, time, and pace, along with today's date, will be transferred to 
your Palm clipboard in a format which is consistent with The Athlete's Diary. This format is a 
series of fields, separated by Tabs. These fields are

1. Date
2. Two upper-case letters, the first represeting type of workout, the second representing the 

sport (see below)
3. Distance, followed by a single letter representing the units of distance
4. Time
5. Pace
6. Route/workout (blank)
7. Carriage return

After selecting Copy All to Memo, the software jumps to the MemoPad application, where you 
can choose the memo into which you want to paste the information. We recommend creating one 
memo for all your data (rather than a separate memo for each entry); a single memo in the Palm can 
contain 4000 characters which should hold quite a few workouts. This memo must contain one 



"header" line, in which you should write something like "Athlete's Diary info" (the actual words 
don't matter). Select that memo, then use the Paste function to paste in your new workout starting on 
the second line of the memo; additional workouts will be pasted on additional lines. Usually one 
workout will "wraparound" and take up more than one line; just make sure the next workout starts on 
a separate line.

Once the data are in the memo, you can modify it or add to it. In the second field, the first letter 
defaults to a T representing training; you can change this to I or R for Intervals or Race, as 
appropriate. The second letter, which represents your sport, is automatically chosen according to the 
pace units. It's set to R for Running if your pace is in minutes per mile or kilometer, to C for Cycling 
if your pace is in mph or kph, and to S for Swimming if your pace is in minutes per 100 yards or 
meters. Again, you can simply change this if it is wrong.

To add in a Route/Workout description, tap at the end of the line (after the Tab following the pace but 
before the carriage return) and enter whatever descriptive material (up to 254 characters if you want 
compatibility with The Athlete's Diary) you want. To add a Comment, insert a Tab and then enter 
your comment. You will not need to add a return, since one is already there.

Once you HotSync your Palm, the file named MEMOPAD.DAT on your desktop computer will contain 
your workouts. If you have version 3.2 of The Athlete's Diary (released May 11, 1997), you can 
use the Merge function of the software to extract your workouts from the MEMOPAD.DAT file with no 
further ado. All your other memos will be ignored; only the one containing information in The 
Athlete's Diary format will be read and extracted (but see the "catch" described below).

To merge the data into your Athlete's Diary log following a HotSync, follow these steps:

Using Windows: simply select Merge from the File menu, select the file MEMOPAD.DAT, 
and click OK.
Using a Macintosh: the Merge function only shows you files of type TEXT, which does 
not include MEMOPAD.DAT. To bypass this restriction, hold down the Option key when you 
select Merge from the File menu; now you'll be able to select MEMOPAD.DAT and merge it 
into your log.
Note that because this is not an "official Palm HotSync," the data will still be in the memo 
on your Palm. Since you don't want to transfer the information twice, the next time you use 
the Palm, select the merged workouts from the memo and delete that text.

Another minor "catch." If you do use this method of moving information from Palm to desktop and 
then into your log, there are some minor restrictions on the other data (other than your workouts) 
which can be in your Palm memos. A line cannot start with a date (e.g., "7/13/97") followed 
immediately by a Tab or The Athlete's Diary will attempt to read that line when you Merge the 
memo.Additionally, if the first word on any line starts with "Sports", "Prefer", "Routes", 
"Keyword", and the first character following the first space on that line is a number, that number of 
lines following the line in question will be skipped when reading the file. Both of these situations 
should be rather unlikely, so you needn't worry about them too much.

If you have an earlier version of The Athlete's Diary, or want to transfer the workout information 
to some other file, you can open the file MEMOPAD.DAT with a text editor. You'll find embedded 
within it (along with your other memos and some non-printing characters), your workout data. If 
you copy and paste this information into a separate file, you'll be able to merge it into your 
Athlete's Diary log. If you are merging using The Athlete's Diary version 3.1 or earlier, 
you'll need to make sure the dates are "zero-padded" (i.e., not 5/6/97 but instead 05/06/97).

Additional reading
Stevens Creek Software manages The Athlete's Bookstore, which sells over a hundred 



book titles of interest to runners, cyclists, swimmers, triathletes, and other fitness enthusiasts.
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